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FEATURES 
(ADC) 
Full featured evaluation board for the ADAQ7980 
Versatile analog signal conditioning circuitry 
On-board reference, reference buffers, and ADC drivers 
SDP board-compatible (EVAL-SDP-CB1Z) 
PC software for control and data analysis of time and 
frequency domain 
(MEMS) 
2 sets of spaced vias for populating 6-pin headers Easily 
attaches to prototyping board or PCB Small size and board 
stiffness minimizes impact on the user system and 
acceleration measurements 

 
EVALUATION KIT CONTENTS 
Assembled Speaker Demo*: 

EVAL-ADAQ7980SDZ evaluation board 
EVAL-SDP-CB1Z data capture board 
(2) EVAL-ADXL100x 
3” Speaker with AUX Cable 
USB Cable 
Power supply, +7.5 V/−2.5 V (optional) 
Speaker-to-Sensor Fixture 
Short/Long Connectors 
Plastic Mounting Base 
Screws 
Nylon Nuts 

*If not assembled, refer to the Speaker Demo Assembly Guide. 
 

EQUIPMENT NEEDED 
PC running Windows® XP SP2, Windows Vista, Windows 7, 
or higher with USB 2.0 port 
Audio Capable Device with 3.5mm AUX Port (optional) 

GENERAL DESCRIPTION 
The EVAL-ADAQ7980SDZ is an evaluation board 

designed to demonstrate the low power ADAQ7980 

performance and provide an easy to understand interface for 

a variety of system applications. The ADAQ7980 is a 16-

bit, 1 MSPS, μModule data acquisition system that 

integrates four common signal processing and conditioning 

blocks into a system in package (SiP) design that supports a 

variety of applications. 

The evaluation board is ideal for use with the Analog 

Devices, Inc., system demonstration platform (SDP) board, 

EVAL-SDP-CB1Z. The EVAL-ADAQ7980SDZ interfaces 

to the SDP board via a 120-pin connector. P1, P2, P3, and 

P4 SMA connectors are provided to connect a low noise 

analog signal source.  

The ADAQ798x Evaluation Software executable controls 

the evaluation board over the USB through the EVAL-SDP-

CB1Z.  A modified version of the software implements 

measurement displays relative to the accelerometer. 

The EVAL-ADXL100x are simple evaluation boards that 

allow users to quickly evaluate the performance of the 

ADXL1001 and ADXL1002 vibration sensors. The EVAL-

ADXL1001Z and EVAL-ADXL1002Z are specifically 

designed to mount onto a mechanical shaker and are 

constructed of an extra thick printed circuit board (PCB), 

measuring 0.8 inches square. Screw holes are supplied for 

rigid mounting to the shaker block. This design allows users 

to evaluate the full performance range of the ADXL1001 or 

ADXL1002 vibration sensor without having to solder the 

device to a separate test board. A simple RC low-pass filter 

is provided at the output with a −3 dB bandwidth of about 

20 kHz. Components can be replaced to allow users to 

implement their own application specific low-pass filter on 

the output of the device. 

The demo brings together the capabilities of both parts to 

demonstrate an effective system for vibration sensing in 

condition based monitoring applications
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EVAL-ADXL100X AND EVAL-ADAQ7980 SPEAKER DEMO 

 

Figure 1.  
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GETTING STARTED 

The following section contains the installation instructions 
for the ADAQ798x Evaluation Software and the drivers for 
the SDP hardware required for operation of the software. 
The evaluation software provides a graphical user interface 
(GUI) for quick evaluation of the ADAQ7980.  

SOFTWARE INSTALLATION PROCEDURES 

Download the evaluation board software from the 
ADAQ7980 product page on the Analog Devices website.  

To install the software, take the following steps: 

• Run the ADAQ798x Evaluation Software installation 
• Run the EVAL-SDP-CB1Z SDP board drivers installation 

Warning 

Install the evaluation board software and drivers before 
connecting the EVAL-ADAQ7980SDZ evaluation board and 
EVAL-SDP-CB1Z board to the USB port of the PC to ensure 
the evaluation system is correctly recognized when it 
connects to the PC. 

Installing the ADAQ7980 Evaluation Board Software 

To install the ADAQ798x Evaluation Software, 

1. Start the Windows operating system and download the 
software from the EVAL-ADAQ7980SDZ product page 
on the Analog Devices website. 

2. Unzip the downloaded file.  
3. Double-click the setup.exe file to begin the evaluation 

board software installation (see Figure 2).  

 

Figure 2. ADAQ7980 Evaluation Board Software Installation—Installation 
Begins 

4. Select a location to install the software and click Next. The 
default location is C:\Program Files (x86)\Analog Devices\ 
ADAQ798x. This location also contains the executable 
software and example files. 

 

Figure 3. ADAQ7980 Evaluation Board Software Installation—Selecting the 
Location for Software Installation (Default Location Shown) 

5. A license agreement appears. Read the agreement, and 
then select I accept the License Agreement, and click 
Next. 

 

Figure 4. ADAQ7980 Evaluation Board Software Installation—Accept the 
License Agreement 
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6. An installation summary displays. Click Next to 
continue. 

 

Figure 5. ADAQ7980 Evaluation Board Software Installation— 
Installation Summary 

7. A dialog box shows the installation progress. 

 

Figure 6. ADAQ7980 Evaluation Board Software Installation— 
Installation Progress 

8. The dialog box informs the user when the installation is 
complete. Click Finish. 

 

Figure 7. ADAQ7980 Evaluation Board Software Installation— 
Installation Complete 

 

9. The setup for the installation of the EVAL-SDP-CB1Z 
SDP board drivers automatically loads. 

 

Figure 8. Loading the Setup for SDP Drivers Installation 

Installing the EVAL-SDP-CB1Z SDP Board Drivers 

After installation of the evaluation board software completes, 
a welcome window displays for the installation of the EVAL-
SDP-CB1Z system demonstration platform board drivers. 
Then, take the following steps: 

1. Ensure all other applications are closed and click Next. 

 

Figure 9. EVAL-SDP-CB1Z Drivers Setup: 
Beginning the Drivers Installation 

2. Select a location to install the drivers and click Install. 

 

Figure 10. EVAL-SDP-CB1Z Drivers Setup:  
Selecting the Location for Drivers Installation 
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3. Installation of the SDP drivers begins. 

 

Figure 11. EVAL-SDP-CB1Z Drivers Setup—Beginning the Installation 

4. A dialog box appears asking to install the SDP software 
available with the EVAL-SDP-CB1Z. Click Install. 

 

Figure 12. EVAL-SDP-CB1Z Drivers Setup—Granting Permission  
to Install Drivers 

5. To complete the drivers installation, click Finish, which 
closes the installation wizard. 

 

Figure 13. EVAL-SDP-CB1Z Drivers Setup:  
Completing the Drivers Setup Wizard 

6. After installing the drivers, restart the PC prior to using 
the ADAQ798x Evaluation Software. A dialog box opens, 
giving the following options: Restart, Shut Down, and 
Restart Later. Click Restart.  

 

Figure 14. EVAL-SDP-CB1Z Drivers Setup:  
Restarting the PC 

Verifying the Board Connection 

To verify the evaluation board connection, take the 
following steps: 

1. Allow the Found New Hardware Wizard to run after the 
EVAL-SDP-CB1Z board is plugged into the PC. If using 
Windows XP, the user may need to search for the EVAL-
SDP-CB1Z drivers. Choose to automatically search for 
the drivers for the EVAL-SDP-CB1Z board if prompted 
by the operating system. 

 
 
2. Verify that the EVAL-ADAQ7980SDZ is connected to the 

PC correctly using the Device Manager of the PC.  
a. Access the Device Manager as follows: 

i. Right-click My Computer and then click Manage.  
ii. A dialog box appears asking for permission to 

allow the program to make changes to the PC. 
Click Yes.  

iii. The Computer Management window appears. 
From the list of System Tools, click Device 
Manager. 

b. Under ADI Development Tools, Analog Devices 
System Development Platform SDP-B appears (see 
Figure 15), indicating the EVAL-SDP-CB1Z driver 
software is installed and the EVAL-ADAQ7980SDZ 
is connected to the PC correctly.  

 

Figure 15. Device Manager:  
Checking the EVAL-ADAQ7980SDZ Is Connected to the PC Correctly 
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EVALUATION BOARD SOFTWARE SETUP PROCEDURES 

EVALUATION BOARD CONNECTION SEQUENCE 

With the evaluation software installed, use the following 
evaluation board operation/connection sequence: 

1. Connect the SDP controller board to the evaluation board 
via the P8 connector (secure the connection using nylon 
screws). The software is configured to find the evaluation 
board on the J2 connector of the SDP board.  

2. Power the EVAL-ADAQ7980SDZ with the appropriate 
supply, as described in the ERROR! REFERENCE 
SOURCE NOT FOUND. section.  

3. Connect the EVAL-SDP-CB1Z board to a PC using the 
USB cable. 

4. Start the evaluation software. Click Start > All Programs 
> Analog Devices > ADAQ798x > ADAQ798x Evaluation 
Software.  

When the software starts running, it searches for Analog 
Devices hardware connected to the PC, first attempting to 
detect and connect to any SDP boards connected to the PC 
via the USB ports. If SDP boards are connected, the software 
attempts to detect the EVAL-ADAQ7980SDZ evaluation 
board connected to the SDP board. If the EVAL-
ADAQ7980SDZ connects, the software runs in the standard 
operation mode. If it does not connect, a dialog box appears 
and prompts the user to either repeat the connection attempt 
or run the software in standalone mode.  

With Hardware Connected 

To run the program with hardware connected, 

1. Follow Step 1 to Step 4 in the Evaluation Board 
Connection Sequence section. 

2. The software then attempts to connect to the SDP board 
and the EVAL-ADAQ7980SDZ. If the SDP board is not 
found, an error window displays (see Figure 16). If the 
SDP board is found but the EVAL-ADAQ7980SDZ is not 
detected, a different error window displays (see Figure 
17). If either connectivity error displays, ensure the 
hardware is properly connected to the USB port of the 
PC, wait a few seconds, click Rescan, and follow the 
instructions. 

 

Figure 16. SDP Board Not Connected to the USB Port Pop-Up Window Error  

 

Figure 17. EVAL-ADAQ7980SDZ Not Connected to the USB Port Pop-Up 
Window Error  

3. After finding the evaluation board, the software 
connects to the EVAL-ADAQ7980SDZ and displays the 
pop-up window shown in Figure 18. 

 

Figure 18. Software Connects to SDP Board 

4. After the EVAL-ADAQ7980SDZ is detected, the main 
window of the software appears (see Figure 20), 
showing that the EVAL-ADAQ7980SDZ is connected. 

Without Hardware Connected 

The software can run in standalone mode when no 
evaluation board hardware is connected to the USB port. 
Use this mode to load previously saved states of the 
ADAQ798x Evaluation Software and view previously 
captured sets of data in the various windows of the 
software.  
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1. Click Start > All Programs > Analog Devices > 
ADAQ798x > ADAQ798x Evaluation Software.  

2. The software attempts to connect to the evaluation 
hardware. If the hardware is not found, either of the 
error messages in Figure 16 or Figure 17 display. To 
continue without hardware in standalone mode, click 
Cancel. 

3. If operating in standalone mode, the window in Figure 
19 displays.  

 

Figure 19. Software Indicates Operating in Standalone Mode 

4. Load example files or previously saved files via File > 
Load data. The contents of the loaded file update the 
various plots in the software.  

5. To connect the EVAL-ADAQ7980SDZ and run the 
software in standard operation, close and relaunch the 
software to allow it to repeat the search for the SDP 
board and the EVAL-ADAQ7980SDZ evaluation board. 
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EVALUATION BOARD SOFTWARE 

 

Figure 20. GUI Main Window 

The following section gives a detailed description of the 
various controls and indicators in the ADAQ798x Evaluation 
Software. For instructions on how to capture and analyze 
data, see the Evaluation Hardware and Software Operation 
section. 

OVERVIEW OF THE MAIN WINDOW 

The main window of the software is shown in Figure 20. 
The following sections describe the various controls that 
are accessible via this window.  

File Menu 

The File menu provides the following options: 

• Load data—load previously captured data. 
• Save Data as .tsv—save captured data in .tsv format for 

future analysis. 
• Save Picture—save the current screen capture as a JPEG 

file. 
• Print—print the current window to the default printer. 
• Exit—close the application. 

Edit Menu 

The Edit dropdown menu provides the Reinitialize Default 
Values option that resets controls to their default state. 

Help Menu  

The Help menu provides the following options: 

• The Analog Devices Website option opens the Analog 
Devices website in the default browser. 

• The User Guide option opens the EVAL-ADAQ7980SDZ 
user guide. 

• The Context Help option opens a window containing 
information about the controls of the software. Help 

text displays in the window when the mouse hovers over 
a control. 

• The About option opens a window displaying the 
software version information. 

Tabs  

There are five tabs available in the tabs area of the main 
window: Configure, Waveform, Histogram, FFT, and Summary. 
These tabs display the data in different formats. Navigation 
tools are provided within each tab to allow the user to 
control the cursor, zooming, and panning (see Figure 21) 
within the graphs displayed. 

Each tab and their respective controls and functions are 
described in the following sections. 

Single Capture Button 

Click Single Capture to perform a single set of captures from 
the ADC. The number of captures is determined by the value in 
Num Samples. 

Continuous Capture Button 

Click Continuous Capture to perform repeated sets of 
captures from the ADC. The number of samples per capture 
set is determined by the value in Num Samples.  

Num Samples Dropdown Box 

The Num Samples dropdown box allows the user to select the 
number of samples to analyze per capture window.  

Busy Indicator 

The Busy indicator indicates when the software is performing 
operations, for example, when running conversions and 
analysis. 
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Exit Button  

Click the Exit button to close the software; alternatively, 
users can select Exit from the File menu. 

CONFIGURE TAB  

The following contains information on the various controls 
accessible in the Configure tab. 

Eval Board Connected Field 

The Eval Board Connected field displays EVAL-ADAQ7980 
when the evaluation board is connected to the USB port. 

When an evaluation board is not connected to the USB port, 
the software can operate in standalone mode for data 
analysis.  

ADC Settings  

The ADC Settings allow changing the sampling rate and serial 
clock frequency via the Sampling Freq (Hz) field and SCLK 
Frequency (MHz) dropdown menu, respectively.  

The reference voltage for the ADAQ7980 must be specified in 
the Reference Voltage (V) field. Use this field for data analysis 
only; it does not alter nor detect the reference voltage on the 
EVAL-ADAQ7980SDZ. For correct data interpretation, input 
the reference voltage being used on the evaluation board. 

By default, the external reference voltage is 5 V (ADR4550  
on-board reference). The minimum and maximum voltage 
calculations are based on this reference voltage. When 
changing the reference voltage, change this input 
accordingly.  

The Sampling Freq (Hz) field sets the sample rate of the 
ADAQ7980, which is equivalent to the frequency of the 
contingent negative variation (CNV) signal of the device. 
The maximum sample rate of the ADAQ7980 is 1 MHz; 
therefore, the Sampling Freq (Hz) field does not allow values 
larger than 1,000,000. This control can interpret SI prefixes. 
Units can be entered as, for example, 10k for 10,000 Hz.  

Oversampling Ratio  

The Oversampling Ratio dropdown menu allows users to select 
the oversampling ratio to improve system dynamic range. 
The oversampling ratio is calculated as 22N, where N is the 
number of bits selected. For example, if N is selected as 2, then 
16 consecutive samples are averaged together to produce 
one sample. This effectively reduces the ADC Nyquist rate by 

a factor of the over-sampling ratio, but at the benefit of 
increased resolution. 

Dynamic Power Scaling  

The Dynamic Power Scaling pane provides dynamic power 
scaling (DPS) configuration options for both the ADC driver 
and the reference buffer. DPS is a power-saving functionality of 
the ADAQ7980. See the ADAQ7980/ADAQ7988 data sheet for 
a description of DPS. 

Both ADC driver DPS settings are controlled by the ADC Driver 
Scaling Enabled OFF/ON box, the PD_AMP On Time field, and 
PD Signal Phase Shift field. The reference buffer DPS settings 
are controlled by the Reference Buffer Scaling Enabled 
OFF/ON check box, the PD_REF On Time field, and the PD 
Signal Delta field. These controls do the following: 

• ADC Driver Scaling Enabled OFF/ON activates DPS for 
the ADC driver when checked. When unchecked, DPS is 
deactivated, leaving the device on constantly.  

• PD_AMP On Time sets the ADC driver on time in a 
sample period. If the value in PD_AMP On Time is larger 
than the sample period, the amplifier remain actives. 

• PD Signal Phase Shift sets the offset of the ADC driver 
on time relative to the CNV signal. 

• Reference Buffer Scaling Enabled OFF/ON activates DPS 
for the reference buffer when checked. When 
unchecked, DPS is deactivated, leaving the device on 
constantly. 

• PD_REF On Time sets the reference buffer on time in a 
sample period. If the value in PD_REF On Time is larger 
than the sample period, the amplifier remains active. 

• PD Signal Delta sets the offset of the reference buffer on 
time relative to the CNV signal. 

Power Down LDO Button 

The Power Down LDO button powers down the ADAQ7980 
integrated LDO, which allows evaluation of the power 
consumption of the ADAQ7980 while in its power-down 
state. 

The Power Down LDO button is not part of the evaluation 
software DPS functionality (see the Dynamic Power Scaling 
section for more information). 

Flash LED Button 

The Flash LED button flashes the LED on the EVAL-SDP-
CB1Z board. Verify that the EVAL-ADAQ7980SDZ and the 
EVAL-SDP-CB1Z are connected. 
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Figure 21. Waveform Tab 

WAVEFORM TAB  

The following sections contain information on the contents 
of the Waveform tab (see Figure 21). 

Waveform Plot 

The waveform plot displays the raw ADAQ7980 results 
obtained during the most recent capture burst. See the 
Generating a Waveform Analysis Report section for more 
information. 

Waveform Analysis 

The Waveform Analysis pane displays important analysis 
parameters on the data in the waveform plot. The indicators 
(except Frequency) are displayed in both volts (V) and 
codes (LSB). The analysis items reference the signal at the 
AMP_OUT pin of the ADAQ7980.  

 

The indicators include the following: 

• Pk-pk Amplitude displays the difference between the 
maximum and minimum values in the data. 

• Max Amplitude displays the maximum value in the data. 
• Min Amplitude displays the minimum value in the data. 
• Mean displays the average value of the data. 
• Standard Deviation displays the standard deviation of 

the data. 
• Frequency displays the frequency with the largest 

amplitude in the data and is only displayed in kHz (see 
FFT Analysis section). 
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Figure 22. Histogram Tab 

HISTOGRAM TAB  

Histogram Plot 

The histogram plot contains a histogram of the results 
obtained during the most recent capture burst (see Figure 
22). This plot shows the number of occurrences for each 
code in the results. See the Generating a Histogram of the 
ADC Code Distribution section for more information. 

Histogram Analysis 

The Histogram Analysis pane displays important analysis 
parameters on the data in the histogram plot. The 
indicators are displayed in volts (V) and codes (LSB), unless 
otherwise specified. The analysis items reference the signal 
at the AMP_OUT pin of the ADAQ7980. 

The parameters include the following: 

• Max Amplitude displays the maximum value in the data. 
• Min Amplitude displays the minimum value in the data. 
• DC Offset/Mean displays the average value of the data. 
• Transition Noise (Pk-Pk) displays the peak-to-peak 

value of the noise of the signal (displayed in μV and LSB 
RMS). 

• Pk-pk Amplitude displays the difference between the 
maximum and minimum values in the data. 

• RMS Noise displays the rms value of the data (displayed 
in μV). 

• LSB displays the equivalent voltage difference between 
each code value (displayed in μV). This value is 
determined by the Reference Voltage (V) control in the 
Configure tab. 

• Histogram Width displays the maximum code in the 
histogram minus the minimum code in the histogram 
(displayed in LSB). 
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Figure 23. FFT Tab 

FFT TAB 

The following contains information on the contents of the FFT 
tab (see Figure 23). 

FFT Plot 

The FFT plot displays frequency analysis of the raw 
ADAQ7980 results from the most recent capture burst. See 
the Generating an FFT of AC Characteristics section for 
more information. 

FFT Analysis 

The FFT Analysis pane displays important ac analysis 
parameters of the data in the FFT plot. The analysis items 
reference the signal at the AMP_OUT pin of the ADAQ7980.  

The parameters include the following: 

• Max Amplitude displays the maximum value in the data 
(displayed in V and LSB). 

• Min Amplitude displays the minimum value in the data 
(displayed in V and LSB). 

• Pk-pk Amplitude displays the difference between the 
maximum and minimum values in the data (displayed 
in V and LSB). 

• DC displays the average value of the data (displayed in V 
and LSB). 

• Fund. Frequency displays the frequency with the largest 
amplitude in the FFT (displayed in kHz). 

• Fund. Amplitude displays the amplitude of the Fund. 
Frequency value (displayed in dBFS, which is dB relative 
to the reference voltage). 

• Dynamic Range displays the ratio of a full-scale signal 
(which is the largest signal the ADAQ7980 can accept 
with amplitude equal to the reference voltage) to the 
noise floor value (displayed in dBFS). 

• RMS Noise displays the rms voltage of the noise floor in 
the FFT plot. Specifically, this calculation includes all 
frequency bins in the FFT plot that are not displayed in 
the Show Harmonic Content window. This value is used 
in calculations for Dynamic Range, SNR, SINAD, and 
SFDR values. 

• SNR displays the ratio of the Fund. Amplitude value to 
the RMS Noise value displayed in dB). 

• THD displays the ratio of the energy in second through 
fifth harmonic frequencies to that of the Fund. 
Frequency value (displayed in dB). 

• SINAD displays the ratio of the Fund. Amplitude value 
to the RMS Noise value and amplitude of the second 
through fifth harmonic frequencies (displayed in dB). 

• Noise Floor displays the ratio of the RMS Noise value 
and the full-scale range of the ADAQ7980 set by 
Reference Voltage in the Configure tab (displayed in dB). 

• Bin Width displays the range of frequencies included in 
each point drawn on the FFT plot. A smaller Bin Width 
value corresponds with higher resolution in frequency 
amplitude information in the FFT plot, affected by the 
Sampling Freq and Num Samples in the Configure tab 
values. For example, increasing the Num Samples value 
while leaving Sampling Freq constant results in a 
smaller Bin Width value. 

• SFDR, the spurious-free dynamic range, displays the ratio 
of the Fund. Amplitude value to the largest spurious 
frequency amplitude (displayed in dB). 

• The Show Harmonic Content button toggles a display 
showing the Fund. Frequency value and the harmonics 
amplitudes. Frequencies are displayed in kHz and 
amplitudes in dBFS. 
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Figure 24. Summary Tab 

SUMMARY TAB 

The following contains information on the contents of the 
Summary tab (see Figure 24). 

Waveform Plot 

The Waveform plot displays the raw ADAQ7980 results 
obtained during the most recent capture burst. See the 
Generating a Waveform Analysis Report section for more 
information. 

Histogram Plot 

The Histogram plot contains a histogram of the results 
obtained during the most recent capture burst. This shows 
the number of occurrences for each code in the results. See 
the Generating a Histogram of the ADC Code Distribution 
section for more information. 

FFT Plot 

The FFT plot displays frequency analysis of the raw 
ADAQ7980 results from the most recent capture burst. See 
the Generating an FFT of AC Characteristics section for 
more information. 

Analysis Summary Window 

The Analysis Summary pane displays important analysis 
parameters on the various plots in the Summary tab, 
including the following: 

• Pk-pk Amp displays the difference between the 
maximum and minimum values in the data (displayed 
in V and LSB). 

• DC Offset/Mean displays the average value of the data 
(displayed in V and LSB). 

• Transition Noise (PP) displays the peak-to-peak value 
of the noise of the signal (displayed in μV and LSB 
RMS). 

• Fund Freq. displays the frequency with the largest 
amplitude in the FFT plot (displayed in kHz). 

• Fund Amplitude displays the amplitude of the Fund 
Freq. value (displayed in dBFS). 

• RMS Noise displays the rms voltage of the noise floor in 
the FFT plot (displayed in μV). 

• SNR displays the ratio of the Fund Amplitude value to 
the RMS Noise value (displayed in dB). 

• THD displays the ratio of the energy in second through 
fifth harmonic frequencies to that of the Fund Freq. 
value (displayed in dB). 

• S/N+D displays the ratio of the Fund Amplitude value 
to the RMS Noise value and amplitude of the second 
through fifth harmonic frequencies (displayed in dB). 

• LSB displays the equivalent voltage difference between 
each code value (displayed in μV). 

• SFDR displays the ratio of the Fund Amplitude value to 
the largest spurious frequency amplitude (displayed in 
dB). 

• Dynamic Range displays the ratio of a full-scale signal, 
which is the largest signal the ADAQ7980 can accept with 
amplitude equal to the Reference Voltage (V) value (in 
the Configure tab) to the noise floor value (displayed in 
dBFS). 
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EVALUATION HARDWARE AND SOFTWARE OPERATION 
The following sections outline how to use the ADAQ798x 
Evaluation Software to capture, analyze and view 
conversion results from the ADAQ7980.  

CAPTURING CONVERSION RESULTS 

The following describes how to collect conversion results 
from the EVAL-ADAQ7980SDZ: 

1. Set the various controls in the Configure tab to the 
desired values. See the Configure Tab section for a 
detailed description of these controls. 

2. Once these controls are set, press either the Single 
Capture or the Continuous Capture buttons in the main 
window to initial conversions. See the Overview of the 
Main Window section for more information on these 
controls. 

GENERATING A WAVEFORM ANALYSIS REPORT 

Figure 21 illustrates the Waveform tab for a dc input signal 
when using the on-board 5 V external reference.  

The Waveform Analysis pane reports the amplitudes recorded 
from the captured signal and the frequency of the signal tone.  

GENERATING A HISTOGRAM OF THE ADC CODE 
DISTRIBUTION 

The Histogram tab can perform ac testing or, more 
commonly, dc testing. This tab shows the ADC code 
distribution of the input and computes the mean and 
standard deviation, which are displayed as DC Offset/Mean 
and Transition Noise (Pk-Pk), respectively, in the Histogram 
Analysis pane.  

Figure 22 shows the histogram of a dc signal applied to the 
ADC input along with the resulting calculations. 

AC Input 

To perform a histogram test of ac input, 

1. Apply a sinusoidal signal with low distortion (better 
than 100 dB) to the evaluation board at the P1/P2 
input SMA connector pair. 

2. Click the Histogram tab from the main window. 
3. Click the Single Capture or Continuous Capture button. 

Raw data is then captured and passed to the PC for 
statistical computations, and various measured values are 
displayed in the Histogram Analysis pane. 

DC Input 

To perform a histogram test of dc input, 

1. If using an external source, apply a signal to the 
evaluation board at the P1/P2 input SMA connector 
pair. It can be required to filter the signal to ensure that 
the dc source is noise compatible with the ADC. 

2. Click the Histogram tab from the main window. 
3. Click the Single Capture or Continuous Capture button. 

Raw data is then captured and passed to the PC for 
statistical computations, and various measured values are 
displayed in the Histogram Analysis pane. 

GENERATING AN FFT OF AC CHARACTERISTICS 

Figure 23 shows the FFT tab. This feature tests the 
traditional ac characteristics of the ADC and displays an FFT 
plot of the results.  

To perform an ac FFT test, 

1. Apply a sinusoidal signal with low distortion (better 
than 100 dB) to the evaluation board at the P1/P2 input 
SMA connector pair. To attain the requisite low 
distortion, which is necessary to allow true evaluation of 
the ADAQ7980, one option is to 
a. Filter the input signal from the ac source. A band-

pass filter can be used; its center frequency must 
match the test frequency of interest. 

b. If using a low frequency band-pass filter when the 
full-scale input range is more than a few volts peak-
to-peak, use the on-board amplifiers to amplify the 
signal, thus preventing the filter from distorting 
the input signal.  

2. Click the FFT tab from the main window. 
3. Click the Single Capture button or Continuous Capture 

button. 

As in the histogram test, raw data is then captured and 
passed to the PC, which performs the FFT and displays the 
resulting signal-to-noise ratio (SNR), signal-to-noise-and-
distortion ratio (SINAD), total harmonic distortion (THD), 
and spurious-free dynamic range (SFDR).  

The FFT Analysis pane displays the results of the captured 
data.  
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GENERATING A SUMMARY OF THE WAVEFORM, 
HISTOGRAM, AND FAST FOURIER TRANSFORM 

Figure 24 shows the Summary tab. The Summary tab 
captures all the display information and provides it in one 
pane with a synopsis of the information, including key 
performance parameters such as SNR and THD. 

 

 

OPERATING THE EVALUATION SOFTWARE IN 
STANDALONE MODE 

The software can run in standalone mode when no 
evaluation board hardware is connected to the USB port. 
Conversions cannot be performed in this mode, but previously 
acquired results can be loaded and viewed in the evaluation 
software environment. Selecting File > Load Data loads a 
dialogue box prompting the file to load. The results can then 
be viewed in the Waveform, Histogram, FFT, and Summary 
tabs. 

 

Figure 25. Loading File Menu 
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MODIFIED SOFTWARE 

The modified version of the software includes extra features in the FFT tab related to the accelerometer.  The plot units can be 
adjusted to display G, mV, and ug/rt(Hz).  The X and Y scale can be adjusted to be linear or logarithmic.  The sensitivity of the 
accelerometer can be entered to act as a scaling factor, as well as noise bandwidth.  There is also an indicator for noise level.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 28. Software Modifications 
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GENERATING SIGNALS WITH THE SPEAKER 

To utilize the software once it is downloaded, an audio file must be played through the speaker.  To ensure proper function, it is 
advised to test the system with discrete tones to ensure that the software yields the proper response in the FFT window.  For 
example, generating a 100Hz tone should generate a peak at 100Hz in the FFT window.  Another good test is to perform a 
frequency sweep and view the FFT window.  The peak should travel across the frequency range. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 29. 100Hz Tone in FFT Window 
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Figure 30. Example of a Full System Setup 

 

 

ESD Caution  
ESD (electrostatic discharge) sensitive device. Charged devices and circuit boards can discharge without detection. Although this product features patented or proprietary protection 
circuitry, damage may occur on devices subjected to high energy ESD. Therefore, proper ESD precautions should be taken to avoid performance degradation or loss of functionality. 

Legal Terms and Conditions 
By using the evaluation board discussed herein (together with any tools, components documentation or support materials, the “Evaluation Board”), you are agreeing to be bound by the terms and conditions 
set forth below (“Agreement”) unless you have purchased the Evaluation Board, in which case the Analog Devices Standard Terms and Conditions of Sale shall govern. Do not use the Evaluation Board until you 
have read and agreed to the Agreement. Your use of the Evaluation Board shall signify your acceptance of the Agreement. This Agreement is made by and between you (“Customer”) and Analog Devices, Inc. 
(“ADI”), with its principal place of business at One Technology Way, Norwood, MA 02062, USA. Subject to the terms and conditions of the Agreement, ADI hereby grants to Customer a free, limited, personal, 
temporary, non-exclusive, non-sublicensable, non-transferable license to use the Evaluation Board FOR EVALUATION PURPOSES ONLY. Customer understands and agrees that the Evaluation Board is 
provided for the sole and exclusive purpose referenced above, and agrees not to use the Evaluation Board for any other purpose. Furthermore, the license granted is expressly made subject to the following 
additional limitations: Customer shall not (i) rent, lease, display, sell, transfer, assign, sublicense, or distribute the Evaluation Board; and (ii) permit any Third Party to access the Evaluation Board. As used herein, 
the term “Third Party” includes any entity other than ADI, Customer, their employees, affiliates and in-house consultants. The Evaluation Board is NOT sold to Customer; all rights not expressly granted herein, 
including ownership of the Evaluation Board, are reserved by ADI. CONFIDENTIALITY. This Agreement and the Evaluation Board shall all be considered the confidential and proprietary information of ADI. 
Customer may not disclose or transfer any portion of the Evaluation Board to any other party for any reason. Upon discontinuation of use of the Evaluation Board or termination of this Agreement, Customer 
agrees to promptly return the Evaluation Board to ADI. ADDITIONAL RESTRICTIONS. Customer may not disassemble, decompile or reverse engineer chips on the Evaluation Board. Customer shall inform ADI 
of any occurred damages or any modifications or alterations it makes to the Evaluation Board, including but not limited to soldering or any other activity that affects the material content of the Evaluation Board. 
Modifications to the Evaluation Board must comply with applicable law, including but not limited to the RoHS Directive. TERMINATION. ADI may terminate this Agreement at any time upon giving written 
notice to Customer. Customer agrees to return to ADI the Evaluation Board at that time. LIMITATION OF LIABILITY. THE EVALUATION BOARD PROVIDED HEREUNDER IS PROVIDED “AS IS” AND ADI 
MAKES NO WARRANTIES OR REPRESENTATIONS OF ANY KIND WITH RESPECT TO IT. ADI SPECIFICALLY DISCLAIMS ANY REPRESENTATIONS, ENDORSEMENTS, GUARANTEES, OR WARRANTIES, 
EXPRESS OR IMPLIED, RELATED TO THE EVALUATION BOARD INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY, TITLE, FITNESS FOR A PARTICULAR PURPOSE OR 
NONINFRINGEMENT OF INTELLECTUAL PROPERTY RIGHTS. IN NO EVENT WILL ADI AND ITS LICENSORS BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR CONSEQUENTIAL DAMAGES 
RESULTING FROM CUSTOMER’S POSSESSION OR USE OF THE EVALUATION BOARD, INCLUDING BUT NOT LIMITED TO LOST PROFITS, DELAY COSTS, LABOR COSTS OR LOSS OF GOODWILL. ADI’S 
TOTAL LIABILITY FROM ANY AND ALL CAUSES SHALL BE LIMITED TO THE AMOUNT OF ONE HUNDRED US DOLLARS ($100.00). EXPORT. Customer agrees that it will not directly or indirectly export the 
Evaluation Board to another country, and that it will comply with all applicable United States federal laws and regulations relating to exports. GOVERNING LAW. This Agreement shall be governed by and 
construed in accordance with the substantive laws of the Commonwealth of Massachusetts (excluding conflict of law rules). Any legal action regarding this Agreement will be heard in the state or federal courts 
having jurisdiction in Suffolk County, Massachusetts, and Customer hereby submits to the personal jurisdiction and venue of such courts. The United Nations Convention on Contracts for the International Sale 
of Goods shall not apply to this Agreement and is expressly disclaimed. 
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